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What is WBmerge? 

WBmerge is a standalone software program created to merge (combine) data from multiple Microsoft 

Excel worksheets contained within multiple Excel workbooks into a single new Excel workbook quickly 

and precisely. It allows users to select only the worksheets and columns they wish to merge. Microsoft 

Excel does not have to be installed to use WBmerge.  

WBmerge can also be used to slice a subset of data from an existing workbook into a new workbook, 

without any risk of human errors. WBmerge was designed to be the fast, easy, and secure way to merge 

multiple Excel workbooks. 

WBmerge offers the user two methods to merge Excel workbooks together. Please note if your 

worksheet order or column order differs from the source workbook, the workbook WBmerge creates 

using “Merge by Position” will contain data, but it will not be in the correct order.   

The “Merge by Name” Merge Type works if your worksheet order or column order differs from the 

source workbook, but it requires the column header names and the worksheet names to match. 

 

Additional Features (Extra Tools): 

In addition to merging data, WBmerge also offers two additional powerful capabilities. 

1 - Split an Excel worksheet into multiple worksheets or multiple workbooks with Worksheet Split. 

2 - Inspect an Excel workbook, including VBA code, with the Workbook Inspector. 

 

Google Sheets Users: 

Since WBmerge does not require Microsoft Excel, it is a perfect fit for Google Sheets users too. If you are 

a Google Sheets user, please download your Google Spreadsheets from you Google Drive to your 

computer. Next follow the directions below for how to use WBmerge to merge or split your data. 

Because Google Sheets has a 5 million cell limit, WBmerge tracks the number of cells written so Google 

Sheets users will know if they have exceeded the Google Sheets limit. 



 

WBmerge will never modify any original source workbooks, it will only read source workbooks. This 

includes merging workbooks, splitting worksheets, and inspecting workbooks and VBA code. 

 

WBmerge Main Program Window 

From the main program window, the user can select the desired activity of merge, split or inspect. Each 

activity is independent and all three can be opened at the same time. 

From the menu on the main program window the user can access the license manager and the quick 

reference help guide, along with multiple other items. 

The user can cancel a running merge, validate only process, or split from the “Tools” menu on the main 

program window. Please note if splitting to workbooks, any new workbooks created before the split is 

cancelled will still exist. 

  

 

 

How to Use WBmerge 

Begin by selecting the desired activity – “Merge Workbooks”, “Split Worksheets” or “Inspect Workbooks 

& VBA” from the main program menu. Next follow the below instructions for each activity. 

Please note you can have multiple activity windows open at the same time. For example, you can start a 

large merge and then split a worksheet or inspect a workbook, all while your merge is still running. 



Below is the Quick Help Reference window, it can be opened from the “Help” menu on the main 

program window. You can open the Quick Help Reference and refer to it at any time. It can be opened at 

the same time as other activity windows. Thus, you can open the Quick Help Reference, then open 

“Merge Workbooks” and refer to the Quick Help Reference as needed. 

 

 

New Versions of WBmerge  
 
It is important to note when new versions of WBmerge are made available you will be prompted to 
install the latest version. Each time you start WBmerge, it checks to see if a new version is available. If a 
new version is required (mandatory), you will have to install it. If a new version is optional, you can elect 
to install it or not.  
 
Version Information - https://www.workbooktools.com/version-info   
Please note that when you install a new version of WBmerge you will be prompted to accept the 

WBmerge license terms.  

 

License Management: 

Users can access the License Manager under the File menu option of the main menu.   

The License Manager allows users to: 

View their current license type and license information. 

Load a new license file - (WBmerge will restart to read the new license file) 

 

Inspect Workbooks & VBA 

Workbook Inspector is easy to use, just select the workbook to inspect and it does the rest.  Please 

note it cannot open a password protected workbook, please remove the password before attempting to 

inspect a workbook. 

Workbook Inspector enumerates the following items for a single workbook: 

Workbook Properties 

Workbook Settings 

Worksheet Details 

Named Ranges 

Pivot Tables 

Tables 

VBA Code & References 

https://www.workbooktools.com/version-info


Please note VBA projects “Locked for Viewing” will only be displayed if the user confirms they are 

authorized to view the protected VBA code. The user assumes all legal responsibility for viewing 

protected VBA code. 

All non-cell data including charts, ink, pictures, SmartArt, and other like objects will be included in the 

count of graphics for each worksheet. 

Below is the Workbook Inspector window, which will open when the user selects “Inspect Workbooks & 

VBA” from the main program menu. 

 

 

Workbook Inspector Window 

What the user will see when they select Inspect Workbooks & VBA 

 

 

 

 

 



Split Worksheets 

Worksheet Split can split data in a single worksheet into multiple new worksheets in a single workbook 
or it can create a new workbook for each split column value with a single worksheet. There can only be 
one split column. 
 
Please note it cannot open a password protected workbook, please remove the password before 

attempting to open a workbook to split a worksheet. 

If a file is too large to split, the user will receive the below error message. If a user receives this message, 
they should try making a copy of the workbook to split and removing any unnecessary columns from the 
split range. It is recommended to limit the number of selected columns when splitting very large 
workbooks. 
 
 

 
 
 
How to use Worksheet Split: 
 
Please follow Steps 1–6 in order.  
 
You will need to create a Named Range or a Table using Microsoft Excel for Worksheet Split to use. The 

range to split must have a minimum of 2 columns and 5 rows. The maximum number of columns in the 

is 250. 

While in Excel, select your data to split, including your column headers. then right click and select 
"Define Name...", this will create a Named Range. 
 
Make sure your range includes column headers on the first row of the range. 
(Duplicate headers and blank headers will cause an error) 
 
The column you select for your split cannot have any blank values or be only whitespace. There can only 
be one split column. Below is the message the user will receive if the selected split column has blank 
values or whitespace.   
 



 
 
The maximum number of unique split values is 1,000. The program will allow you to open a range with 
more than 1,000 unique split values, but the user must reduce the selected unique values to 1,000 or 
less. 
 

Step 1 allows the user to select the input workbook and the Named Range or Table to use as the source 

of the split. 

Step 2 allows the user to select the split column and the split values to include in the split output - new 

worksheet(s). 

Step 3 allows the user to select the columns to include in the split output - new worksheet(s). 

Step 4 Allows the user to change the output order of the selected column names in the new 

worksheet(s). 

Step 5 is optional; it allows the user to add a secondary sort order to the output. The primary sort order 
will always be the column selected to split. You may sort on any column(s) in the source Named Range 
or Table, even if they are not included in the split output. 
 
Step 6 is where the user will select the split type and setup all the split configuration parameters 
described below. 
 
New worksheet names will be based on each unique split value. Excel limits worksheet names to 31 

characters. Worksheet names will contain the first 31 characters of each split value. The user can enter 

the name of the worksheet when splitting to workbooks, this is optional. If the new worksheet name 

text box is left blank when splitting to workbooks, the software will create the worksheet name based 

on the name of each unique split value. 

The user has the option to append a Prefix and/or Suffix (up to 25 characters for each) to the workbook 

names when splitting to workbooks. 

The user has the option to “Add a Table to each Worksheet”. The table name will be the name of the 

worksheet with a “_” appended to the front of the worksheet name. This option is enabled by default. 

There is a performance penalty for this option with large data sets and turning it off will improve the 

total time to complete a split. 

The user has the option to “Copy Number Formatting” from the source cell to the new cell. This option is 

enabled by default. There is a performance penalty for this option with large data sets and turning it off 

will improve the total time to complete a split. If you disable "Copy Number Formatting" the split will 

run faster but all Non-Generic Excel Number Formatting will be lost. 



The user has the option to “Add a Uniquifier to Workbook / Worksheet names”, an incrementing 

number starting at 0. When splitting to worksheets the Uniquifier adds up to four (4) characters to the 

end of the worksheet name. And when splitting to workbooks the Uniquifier adds up to four (4) 

characters to the end of the workbook name.  

 

There is a process status box on the lower right corner of the Worksheet Split window. The process 

status box will show when a workbook is opening, a range is selected, and split column is selected. 

When a split is executed, this box will show the type of split and the time the split started. When the 

split completes the end time will be recorded in the process status window.  

The user can cancel a running split process from the “Tools” menu off the main program window.  

Please note if splitting to workbooks, any new workbooks created before the split is cancelled will still 

exist. 

 

Below are six (6) screenshots of the six (6) steps to perform a Worksheet Split.  

 

 



 



 

 



 



 

 



 

 

 

Merge Workbooks 

The below window will open when the user selects “Merge Workbooks” from the main program 

window. The user must select the merge type when they select “Merge Workbooks” from the main 

program window. The user can change the merge type by pressing the Clear / Reset button. 

Please note that merging by position takes the position of the selected worksheets and columns from 

the source workbook and uses those positions against all selected worksheets.  If the order of your 

columns or worksheets is not the same across all files, the merged workbook will not be consistent.  

If you have worksheets or columns in differing orders, please use “Merge by Name”. “Merge by 

Position” was created for users with multiple workbooks with the same data in the same order, but 

differing worksheet names and or column names. “Merge by Position” validates the input workbooks 

can be successfully opened, it also checks for partial worksheets. It performs no other validations or 

checks against the worksheets or columns. This process is referred to as a Basic Validation. 

 

 



“Merge by Position” does not support the following: 

1. Templates 

2. Worksheet Re-Ordering 

3. Strict Column Matching 

4. Strict Worksheet Matching 

5. Non-Null Columns 

“Merge by Position” 5 allows the user to merge multiple workbooks with multiple worksheets where the 

worksheet names and column names do not match. 

Please follow the below steps in this section to properly merge workbooks using WBmerge. Please note 

WBmerge reads cell values and not formulas, the merged workbook will contain the value of the source 

cell containing a formula. 

The user begins by selecting “Select Workbook” or “Open Template”. When they open a workbook or 

template, they have the option to set the header location for each worksheet. Once this step completes 

the Worksheet/Column Selection Tree will populate. 

The user will use the Worksheet/Column Selection Tree to select the worksheets and columns to include 

in the merge. The user can change the worksheet and column order from this window.  

There are seven (7) merge options the user can set from this window. Later in this help guide is a 

step-by-step section on performing a merge with more information on each option.  

 



The below two images show the merge form window for both a “Merge by Name” and “Merge by 

Position”. The merge type indicator is highlighted in yellow to contrast the two different merge types. 

 

 

 

 

 



Select Data Header Rows Window 

 

If the header row for any worksheet is not on row one (1) of the worksheet, you will need to make sure 

to properly set it here. 

 

 

 

 

 

 

 



Change Worksheet Order (Merge by Name only) 

The user can use this feature to change the order of the worksheets or remove worksheets. Multiselect 

is supported for remove only. It is recommended to remove unwanted worksheets first using 

multiselect. If you make a mistake press Cancel Changes and start over. A template can be used to save 

any changes to the worksheets made in this step. When closing the Workbook Merge window, you will 

be prompted to save your pending worksheet changes to a template. This feature will not change your 

original source workbook or template. If you opened a template, you would need to create a new one to 

save your changes. 

 

 

 

 

 

 



Change Column Order (Merge by Name only) 

The user can use this feature to change the order of the columns or remove columns from a worksheet.  

You will need to use this feature for each worksheet you wish to make column changes. Multiselect is 

supported for remove only. It is recommended to remove unwanted columns first using multiselect. If 

you make a mistake press Cancel Changes and start over. A template can be used to save any changes to 

the columns made in this step. When closing the Workbook Merge window, you will be prompted to 

save your pending column changes to a template. This feature will not change your original source 

workbook or template. If you opened a template, you would need to create a new one to save your 

changes. 

 

 

 

 



Merge Data Setup Window 

 

The user will set the new workbook name and location in this window. They will also select the files to 

include in the merge. A template can be used to save any changes to the columns made in this step. 

 

 

 

 

How to use WBmerge Step by Step: 

 

1. Select a source Workbook or open an existing WBmerge Template. 

 



• To begin, press the “Select Workbook” button on the main WBmerge program window and 

follow the instructions. The worksheets and columns in the source workbook will be loaded into the 

"Worksheet / Column Selection Tree". Next select the desired worksheets and columns to merge. You 

can also select if specific columns must have data by using the "Cannot Be Null" checkbox next to the 

column in the "Worksheet / Column Selection Tree". The name of the selected workbook will be 

displayed in the “Workbook Source File” once opened. 

 

• Do my selected columns have to be in the same location on each worksheet? No, WBmerge will 

find your columns provided they exist on the defined header row. If some of your workbooks to merge 

have extra columns, it will not impact WBmerge provided the extra columns are not selected as part of 

the merge. Please make sure to only select columns you know exist in all your workbooks. 

 

• How do I know what source workbook to use? Think of the source workbook as a guide to help 

WBmerge understand your workbook structure. If you have multiple workbooks to merge, you can use 

any of those workbooks as the source. If you wish to slice data from a single workbook, then that 

workbook will be your source workbook. Please note the source workbook is only used to populate the 

"Worksheet / Column Selection Tree", it is not automatically added to the workbooks to merge list. If 

you wish to include it in the merge you must add it as a file to merge when you reach that step in the 

process. 

 

• When you open the source workbook you will be asked if all data headers are on row one (1).  

If they are not, the Select Data Header Rows window will open to allow you to select where your header 

rows are located. You can select the header row by individual worksheet, or you may set all header rows 

to the same row for all worksheets. Header rows must be on a row between row 1 and 100. Press the 

“Selections Complete” button to close the Select Data Header Rows window.  

 

• There are six (6) buttons below the "Worksheet / Column Selection Tree" that can be used to 

expand the tree, collapse the tree, select all worksheets and columns, deselect all worksheets and 

columns, modify worksheet order (Merge by Name only) and modify column order (Merge by Name 

only).  

 

• The “Clear / Reset” button will clear the "Worksheet / Column Selection Tree" and the “Results 

Window”.  It will also allow you to switch the merge type between “Merge by Name” and “Merge by 

Position”. 

 

• If all selected columns can be Null, WBmerge will read each desired data row until it reaches the 

first row without any data in any selected column. If any column is cannot be Null, WBmerge will stop 

reading data once a blank column is encountered for a column marked "Cannot Be Null". You can mark 

multiple columns as "Cannot Be Null". (Merge by Name only) 



2. Set the Merge Parameters 

 

 

 

• Strict Column Matching (Merge by name only) - This option is disabled by default (unchecked). 

When you remove the check from this option WBmerge will allow merges to occur with partial column 

matching. If a partial column merge is selected and a non-present column is marked as "Cannot Be Null", 

then the affected workbook will not be merged. If "Strict Column Matching" is enabled, all selected 

workbooks to merge without an exact match on all requested columns will be excluded from the merge. 

WBmerge will write non-existent column data cells with an empty cell. If no columns exist for a 

worksheet within a source workbook, then no data will be written.  

 

• Strict Worksheet Matching (Merge by name only) - This option is disabled by default 

(unchecked). When you remove the check from this option WBmerge will allow merges to occur with 

partial worksheet matching. If your merge requests a total of four (4) worksheets and three (3) exist and 

one does not the workbook will be included in the merge. If "Strict Worksheet Matching" is enabled, all 

selected workbooks to merge without an exact match on all requested worksheets will be excluded from 

the merge.  

 

• Copy Number Formatting - This option is enabled by default (checked). This option will copy the 

Excel Number Format from each source cell to each target cell. There is overhead in copying the Excel 

Merge Parameter Default Status Enabled Disabled

Strict Column Merge Disabled

Workbooks selected to merge without all requested 

columns will be excluded from the merge.

Workbooks selected to merge without all requested 

columns will be included in the merge. A partial 

column merge will occur.  Please note that columns 

marked as "Cannot Be Null" cannot be excluded.

Strict Worksheet Merge Disabled

Workbooks selected to merge without all requested 

worksheets will be excluded from the merge.

Workbooks selected to merge without all requested 

worksheets will be included in the merge. A partial 

worksheet merge will occur.

Copy Number Formatting Enabled

Copies the Excel Number Format from each source 

cell to each target cell.

No formatting is copied from the source cell.

Results Shading Enabled

Every other results data set will be shaded in light 

blue to separate it from the previous data set.

No results data shading is performed.

Add Table to Worksheets Enabled

An Excel table will be added to each worksheet, 

except for the "WBmerge-Results" worksheet.  The 

table name will be the name of the worksheet with 

a “_” appended to the front of the worksheet name.

No tables will be added.

Add WBmerge-Results Enabled

Add the WBmerge-Results worksheet to the new 

workbook.

WBmerge-Results worksheet will not be added.

Add WBmerge-Key Enabled

Adds the corresponding WBmerge-Key to the end of 

each new row.

No WBmerge-Key will be added.



Number Format from source cells to target cells. If you disable "Copy Number Formatting" the merge 

will run faster but all Non-Generic Excel Number Formatting will be lost. You can reapply the number 

formatting back after the merge. Note, number formatting is not copied for empty cells. 

 

• Results Shading - This option is enabled by default (checked). Every other results data set will be 

shaded in light blue to separate it from the previous data set. There is a performance penalty for this 

option with large data sets and turning it off will improve the total time to complete a merge. 

 

• Add Table to Worksheets - This option is enabled by default (checked). An Excel table will be 

added to each worksheet, except for the "WBmerge-Results" worksheet. The table name will be the 

name of the worksheet with a “_” appended to the front of the worksheet name. There is a 

performance penalty for this option with large data sets and turning it off will improve the total time to 

complete a merge. 

 

• Add WBmerge-Results - Add the WBmerge-Results worksheet to the new workbook.  

 

• Add WBmerge-Key - Adds the corresponding WBmerge-Key to the end of each new row.  

 

 

3. Execute the Merge 

 

• Press the "Merge" button. If you wish to only validate your workbooks to merge without 

performing a merge, then press the "Validate Only" button". The Merge Data Setup window will now be 

displayed to the user. 

 

4. Data Setup  

 

• The Merge Data Setup window allows the user to tell WBmerge the name and location for the 

new workbook (.XLSX file) to create. The user must also select the workbooks to merge into the new 

workbook. For Validate Only, users will only need to select the workbooks to validate. 

 

• The Merge Data Setup window allows the user to select the workbooks to merge by File or 

Folder, which is controlled by a button on the form. The user must set the button to the desired option, 

then press the “Add Items” button. The user can switch back and forth between Files and Folders.  



When the Folder option is used, all .XLSX and .XLSM files within the selected folder will be added to list. 

The select by Files option allows the user to select one or multiple workbooks at one time.  

  

• There is a Remove Items option that allows the user to remove one or multiple workbooks from 

the list. To remove items the user should first highlight the workbook or workbooks to remove, then 

press the “Remove Items” button. 

 

• You can see the number of workbooks you have selected by looking at the workbook counter 

below the “Workbooks to Merge” window. This is helpful when working with many workbooks. 

 

5. Manage Merge Validation Errors (Merge by Name) 

 

• If validation errors are found during a merge, a window will be presented to the user displaying 

all validation errors. The reason for validation failure will be shown next to each workbook. 

 

• The user can elect to continue the merge or cancel it. If the user continues the merge, all 

workbooks failing validation will not be included in the merge. 

 

• When a user runs a “Validate Only” the validation errors window will not be displayed, rather 

the user needs to review the “Results Window” to review the validation results.   

(A long running Merge or Validate Only can be cancelled from the menu on the main program window) 

 

6. Open your new Merged workbook 

 

• Open your new workbook and review the results and consume your data. Please note, 

WBmerge adds an extra worksheet to the new workbook named “WBmerge-Results”, please see the 

Advanced Topics section below to learn more about the “WBmerge-Results” worksheet. 

 

WBmerge Templates (Merge by Name only) 

 

• Once you open a source workbook and make your worksheet and column selections, you may 

save them off to a WBmerge Template for future use. Just press the “Save To Template” button and 

follow the instructions. All the worksheets and columns in the source workbook will be added to the 

new WBmerge Template along with your worksheet, column and “Cannot Be Null” selections. The 



header rows displayed for the source workbook will be added to the WBmerge Template. You can share 

WBmerge Templates with other WBmerge users. 

 

• To open an existing WBmerge Template, press the “Open Template” button. The "Worksheet / 

Column Selection Tree" will be populated based on the selections stored in the WBmerge Template.  

Users can edit the selected worksheets and columns if desired, along with controlling columns that must 

have data via the "Cannot Be Null" checkbox. When a "Worksheet / Column Selection Tree" is displaying 

the results of a WBmerge Template, the name of the WBmerge Template will be displayed in the 

"Template File Name" box at the top of the main program window.   

 

• When you open a WBmerge Template the Select Data Header Rows window will open to show 

you where the header rows are set for each worksheet. You can change the header rows from this 

window, but they will not be saved back to the WBmerge Template you just opened. Any header row 

changes you make will be applied to any merges you run while the WBmerge Template is open. If you 

wish to save your header row changes, you may save them to a new WBmerge Template. 

 

• When a WBmerge Template is loaded, the name displayed in the “Workbook Source File” will be 

the name of the workbook the WBmerge Template was originally created from. The workbook may no 

longer exist, but that will have no impact on the merge or validate only operations. A WBmerge 

Template has no dependency on the source workbook it was created from. 

 

• To create a new WBmerge Template from an existing WBmerge Template, open the existing 

WBmerge Template and make your changes. Then press "Save to Template" and follow the instructions 

to create your new WBmerge Template.   

 

Understanding the “WBmerge-Results" worksheet: 

 

The “Results Window” on the main program window provides information about the current running 

process. You can save the content of the "Results Window" to a text file (.TXT), press the "Save Results 

to File" button. If the system experiences an unexpected error, please make sure to capture the 

contents of the "Results Window" as soon as the error occurs, this will help in troubleshooting the issue. 

Look at the worksheet named "WBmerge-Results" in your newly created workbook. It includes a lot of 

the same data that is displayed in the "Results Window".  

 

 

 



The "WBmerge-Results" worksheet incudes the below columns: 

 

• Merge Start Date/Time     One item only  

• WBmerge Version      One item only 

• WBmerge Template File     One item only 

• WBmerge Source Workbook     One item only 

• Strict Column Matching     One item only 

• Strict Worksheet Matching     One item only 

• Copy Number Formatting     One item only 

• Results Shading     One item only 

• Add Table to Worksheets     One item only 

• Count of Merged Workbooks     One item only 

• Count of Merged Sheets     One item only 

• Count of Merged Columns-     One item only 

• WBmerge-Key       One per workbook merged 

• Merged Workbook Name     One per workbook merged 

• Merged Workbook Path    One per workbook merged 

• Validation Status     One per workbook merged 

• Merge Date/Time     One per workbook merged 

• Count of Merged Worksheets    One per workbook merged 

• Sum of Merged Data Rows    One per workbook merged 

• Sum of Data Rows NOT Merged (Exceeded Capacity) One per workbook merged 

• Worksheet Name     One per worksheet included in the 

merge 

• Header Row      One per worksheet included in the 

merge 

• Data Rows Written     One per worksheet included in the 

merge 

• Data Rows NOT Written (Exceeded Capacity)  One per worksheet included in the 

merge 



• Data Cells Written     One per worksheet included in the 

merge 

 

Each merged workbook is assigned a "WBmerge-Key" displayed in the "WBmerge-Results" worksheet.  

Each data record has a "WBmerge-Key" located at the end of each record to be able to identify the 

source merged workbook the record originated from. The "WBmerge-Key" can be used to perform the 

Excel VLOOKUP function against the merged data and used to slice the data when added to a pivot 

table.  

 

Understanding Data Loss 

 

Excel has a maximum limit of 1,048,576 rows per worksheet. If a merge exceeds this capacity, the user 

will be warned for each worksheet this condition occurs on. They will receive a popup window and this 

data will be written to the "Results Window" and the "WBmerge-Results" worksheet in the new 

workbook. 

• WARNING Data Loss ==> Maximum Data Rows of 1,048,575 Written to Sheet “Sheet Name” / 

Data Rows Found but Not Written = “Number of Rows Not Written” 

Please note a WBmerge Data Loss Warning means that data could not be written to the new combined 

file because of this limitation in Excel. The original source .XLSX and XLSM files remain the same and are 

never altered. The Data Loss Warning message only applies to the new combined workbook. 

 

System Specifications 

 

• Windows Operating System Supported – Windows 7 or higher & Windows Server 2012 R2 or 

higher 

• Computer CPU – No specific CPU requirement 

• Computer Memory – 2 GB recommended (larger merges will require larger amounts of memory) 

• Computer Display – 1024 x 768 minimum display supported (Display changes require user sign 

out of Windows and re-login to Windows) 

 

Please note that low disk space can cause Windows system problems including affecting the 

performance and behavior of WBmerge. 

 

The Microsoft .NET Framework 4.7 or higher is required. The WBmerge installer will check for this and 

help make sure this is installed during program setup. 



WBmerge utilizes EPPlus 4.5.3.3 Interfaces - Licensed under GNU Lesser General Public License (LGPL) 

v3.0 (License Information- https://www.gnu.org/licenses/lgpl-3.0.en.html). The WBmerge installer will 

install EPPlus during program setup. 

 

WBmerge utilizes the MySQL Connector/NET 8.0 Interfaces - Licensed under GNU General Public License 

Version 2.0, June 1991 - MySQL Connector/NET 8.0 Interfaces are consumed via a published NuGet 

package (https://www.nuget.org/packages/MySql.Data/8.0.30). The WBmerge installer will install 

MySQL Connector/NET 8.0 Interfaces during program setup. 

 

Workbook Requirements to be included in a Merge: 

 

• Worksheet Columns must have Headers Names on the same row for all columns 

• Header Rows may be on any row between row 1 and 100 

• Header Rows can be on different rows in each worksheet 

• Worksheet Names must match exactly (Case sensitive check made) 

• Worksheet Column Header Names must match exactly (Case sensitive check made) 

• Worksheet Name cannot contain "WBmerge-Results" 

• Column Name cannot contain "WBmerge-Key" (unless Add WBmerge-Key is disabled) 

 

Supported File Types 

 

• .XLSX (Excel 2007 and higher Default Excel File Type) 

• .XLSM (Macro enabled Excel Workbook) - No VBA Code is ever executed 

 

Non-Supported File Types: 

 

• .XLS (Excel 97-2003 Workbook) 

• .XLSX (Strict Open XML Document) Looks like an XLSX workbook but is not the same internal 

format 

• .XLSB (Binary Excel Workbook) 

• .ODS (Open Document Spreadsheet) 

• .CSV (Comma Separated Text File) 

https://www.gnu.org/licenses/lgpl-3.0.en.html
https://www.nuget.org/packages/MySql.Data/8.0.30


• .XML (Extensible Markup Language File) 

 

Password Protection 

 

• The program cannot open password protected Workbooks.   

• The program can read password protected worksheets. 

• The program can read hidden worksheets and Columns  

• The program can read worksheets marked Very Hidden 

 

Workbook Tools, LLC is not affiliated in any way with Microsoft. 'Microsoft' is a registered trademark of 

Microsoft Corporation.  

 

Copyright 2019-2024 Workbook Tools, LLC 


